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Chapter 1

Welcome
Control Centre is the administrative hub of Sage Taxation. There are certain tasks you will need to
carry out in Control Centre before you can start using the other Taxation programs, such as creating
a Dataset and setting up your users.

You can carry out all of the following functions in Control Centre. However, if you are using Sage
Practice Solution, there are some activities that would be better carried out in that program rather
than Control Centre. These are markedwith an asterisk.

Workflow for Setting up Sage Control Centre:

1. Log on to Control Centre. See Starting Control Centre on page 1.

2. Create a Dataset (you'll need the Administrator password to do this). See To create a new
dataset on page 3.

3. *Create your Practice client. Some practice information will be required by Control Centre but
your main practice details will be stored in Sage Practice Solution. See What is the Practice
Client? on page 3

4. Set up your staff members. See Setting up your staff members on page 4

Control Centre is also used to:

n *Add, amend and delete client information

n *Access all of the Sage Taxation programs from one location

n Create letters

n *Produce reports. Some reports will be available in Sage Practice Solution but tax orientated
reports will only be available in Control Centre

n *Record tasks and their status

n *Link clients to other products

n File returns by Internet (FBI)

n Configure Annual Data Questionnaire (ADQ) templates

n Perform batch ADQ creation

n Update your client limits

n *Administer links to other Sage programs.

Starting Control Centre
Double-click the Sage Compliance shortcut on the Windows Desktop. Alternatively you can use the
shortcut that was added to the Start Menu in Programs > Sage > Sage Taxation > Control Centre.

Signing in
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When you start Control Centre you will be prompted to select a username and password. The first
time you sign in use Test User as the Name and leave the Password blank.

You can then create your own set of users with unique usernames and passwords. You should also
create your own administrator password. We will cover this later in this guide.

In Help, look for: Staff

Administrator password
Tomaintain the security of your data you will be prompted to enter an Administrator Password to
perform certain functions, such as:

n deleting client

n changing users' access rights.

The default administrator password is egas. When using the program, you can prevent being asked
for the Administrator password for your current session by selecting the Do not ask for this password
again check box when it appears.

In Help, look for: Key concepts of Control Centre > Administrator > Changing the Administrator
Password

Datasets
A Dataset is a way of grouping clients together into different categories. The way in which these
categories are defined is entirely up to you. You give the dataset any name you choose and you can
create as many datasets as you need. In this way you can group your clients in a way which mirrors
any method of dividing up clients which already exists in your practice. When you run Control
Centre you are asked to select a dataset (unless you have made a particular dataset the default one)
in the Open Dataset window. Only the details of the clients in the dataset that you choose are then
accessible in Control Centre.

The first time that you open Control Centre after installing Sage Taxation you will be prompted to
create your first dataset. You cannot create clients or enter data in any Sage Taxation system
without doing so. For example, if you try to access Personal Tax before creating your first dataset in
Control Centre, you will be informed that you must do this before you can proceed.

In the Client Navigator, the name of the currently selected dataset is displayed above the Client List
in the drop-down list - in this example it is Default dataset.

Datasets are always created andmaintained by an Administrator using Control Centre.
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To create a new dataset

1. After signing in to Control Centre you will see a message advising you to create a Dataset.
Click Yes.

2. You will be prompted to enter the Administrator password. Enter the password (this will be
egas unless you have changed it.) 

Click OK.

3. The New Dataset Wizard appears. Click Next.

4. Enter a name for your dataset. For example, you may want to name it after your regional
office. Click Next.

5. Click Next. A summary of the dataset you are about to create is displayed. Click Back to
change the settings or Next to create the Dataset.

6. When the Dataset has been created, the Practice Client Wizard appears.

What is the Practice Client?
The Practice Client is a special client in Taxation that stored simple information about your practice.
This information is used to automatically populate the tax returns, and other reports and letters in
Control Centre. It is also usedwhen you file online.

If you are using Sage Practice Solution, you will use that program to store fuller details about your
practice.

A practice client is created in the same way as a standard client and appears within your system in
the same way as a normal tax client. You can choose to hide this client from reports.

To create the Practice Client

1. The New Practice Client Wizard will have started automatically after the New Dataset Wizard
finished. Click Next.

2. To help keep the Practice Client separate from the rest of your clients, choose Other as the
business type. Click Next.

3. A summary page appears. Click Next.

4. The New Other Wizard appears.
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Click Next.

5. Enter the Primary name, Correspondence name and Report name then click Next.

6. Enter the Practice Client’s contact and tax details. Click Next.

7. Enter PRACTICE as the Client Code for the practice. This will make it easier for you to find
your client. Enter a Billing Code and click Next.

8. Select whether to set a password for the Practice Client andwhether to exclude it from
reports. Click Next.

9. A summary page appears. If you want to make any changes, click Back otherwise click Finish.

Your Dataset and Practice Client have now been created and you will see the Control Centre
interface.

Setting up your staff members
A staff member is a person within your practice who will have access to Sage Taxation. You should
create a user profile for each staff member, which allows you to control their access to the software,
allowing varying levels of security and access to the system.

If you want to get started quickly using Taxation, you may choose to create only some of the users.
You can create others later.

Note: If you are using Sage Practice Solution you should already have set up your Staff in that
program. However, you still need to create users in Taxation.

To create a user profile

1. Within Control Centre, from the Tools menu choose User List. The Staff Lookupwindow
appears.

2. Click Add. The New User Details window appears.
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What do I do? Why?

Enter the user’s forename, surname and tel-
ephone number.

These details will be used
throughout Sage Taxation.

Enter a staff code for the user. If you do not
enter a staff code, one will be created auto-
matically using the user’s initials.

The staff code can be used
as a shortcut to select the
staff member within Sage
Taxation.

Enter password details for the user. Tick the
Password protect box if you wish to set a
password for this user.

Using a password adds secu-
rity.

3. The System Access tab allows you to determine how much access each user has to each of
the programs within Sage Taxation.

What do I do? Why?

Set the options for each
system. Choose from the
following:

If no changes are made to this tab, then the default selections
are to set ‘Delete, Add andModify’ for Control Centre, and No
Access for all other programs.
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What do I do? Why?

No Access The user will not be able to access the program.

View Only The user will be able to open the program and view
information, but will not be able to add or amend any data.

Modify Only The user can access the program andmake changes to exist-
ing information, but cannot add records or delete existing rec-
ords.

Add andModify The user can access the program,make changes to existing
records and add new records, but does not have permission to
delete data.

Delete, Add and
Modify

This is full access for the user who will be able to add new
records, make changes to existing records and delete records.
Certain restricted functions will however, still require the
administrator password.

4. Once all information has been entered, click OK. The new username will appear in the list of
users on the Staff Lookupwindow.

5. You may change a user’s profile details at any time by selecting the username from the list
and clicking Edit.

Setting up your employees, partners andmanagers as users allows you to assign tasks and pass
information between users within the system through the use of the Tasks functionality.

Note: As it is not possible to delete users from Taxation, we recommend editing the details of Test
User with the details of a partner or staff member.
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Chapter 2

Finding your way around Control Centre
The main Control Centre window is made up for the following areas:

n Main Menu and Toolbar: From here you can access all the functions in Control Centre. For
example, this is where you open the Annual Data Questionnaire. All the functions can be
found in the main menu, but some frequently used functions are also available on the toolbar
for easy access.

n Client List: The client list shows all of the clients that you have set up in Sage Taxation. Use
the drop-down boxes at the top of the list to filter the results shown. You can also choose
which client details to show in the list, by right-clicking on the client list, choosing
Add/Remove column, and then selecting the details you want to see in the list. You can
remove items by simply repeating this process and clicking on the detail you wish to remove.

n Client information window: This will show the details for the client that is currently selected in
the client list. The first tab shows a summary of the clients details. You can see other
information by clicking the tabs at the top of the window.
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Chapter 3

Connecting your Sage programs
With Practice Solution you can share your client data between Sage products for practice.

Connected programs:

l Sage Accounts Production

l Sage Accounts Production
Advanced

l Sage Corporation Tax
(powered by Abacus)

l Sage Taxation

When you install Practice Solution, or any of the products listed above, the connections will not be
enabled. This is to make sure that you are comfortable with your new software before you begin
sharing your client data.

Note: Sage 50 Accounts is used by Practice Solution for billing. This integration is available in
Practice Solution after the billing system has been configured in Sage Practice Solution Control
Panel.
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Connecting with Sage Practice Solution
Sage Practice Solution allows you tomanage your clients’ details, link to other Sage products for
practice, record time against work carried out for them and create invoices based on that time.

The software comprises two elements:

n Practice Hub

n Time recording and invoicing

Your licence agreement with Sage will determine which elements are available.

Sage Practice Hub is the central store for your client data. You can use Sage Practice Hub to connect
your Sage Programs, for tasks, communications, reporting, letter writing etc.

We refer to Sage Practice Hubwith Time recording and invoicing as Sage Practice Solution.

More information
For more information about connecting your Sage programs with Sage Practice Solution, start Sage
Practice Solution (v1.5 or above) and from the Helpmenu choose Contents. When the Help system
appears, use the table of contents to find the book Connecting your Sage Programs.
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Chapter 4

Creating a client
You can add a new client to the current dataset in any of the followingways:

n Click the New button on toolbar.

n From the File menu choose New Client.

n Right-click on the Client List and choose New Client from the menu.

Either of these methods will cause the New Client Wizard to appear. For more assistance at any
stage of creating a client, click Help on the wizard.

Note: If you use Sage Practice Solution and have client integration enabled, clients created in Sage
Taxation will automatically be available in Sage Practice Solution. For more information see
Connecting with Sage Practice Solution on page 9.

Create a client
This procedure illustrates how to create a partnership in Control Centre. Other client types are
similar.

1. From the File menu, choose New Client. The New Client Wizard appears. Click Next.

2. Select Partnership as the Client Type. Click Next.

3. Select the tax products to use with the client. Select both Partnership Tax and Business Tax.
Click Next.

4. The wizard displays a summary of your selections. Click Back to change any of your previous
choices or Next to continue.

5. In this example we are creating a partnership, so the New PartnershipWizard appears. Click
Next.

6. Enter the Trading Name, Correspondence Name, and Report Name. Click Next.

7. Enter the contact details and UTR for the partnership. Click Next.

8. Click Add to start adding partners to the partnership. The Client Lookupwindow appears.

To add a partner that already exists in Sage Taxation, choose the client from the list
then click Select.

To create a partner, click New on the Client Lookupwindow andwork through the New
Client Wizard. When the wizard completes, your new client will be available in the
Client Lookup list; choose the client from the list then click Select.

Once you've added all the partners, click Close on the Client Lookupwindow to return to the
New PartnershipWizardthen click Next.
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9. Enter the reference codes you want to use for the client.

The client code is automatically generated from the first three letters of the client
name followed by 100 - or the next available number (i.e. if BIG100 already exists,
then the client code will default to BIG101). You may want to change this code to tie in
with an existing scheme in your practice.

The Billing code is the code of the client to whom any work will be charged. If charges
will be billed to the client you are currently creating, then you should set this code to
Default; which will set it to the same as the client code. However, if all charges are to
be billed to another client, then you can select their client code here. Click on the
magnifying glass button to see a list of clients within this dataset that you can choose
as the billing client.

You may also record which staff member introduced the client to the business.

Click Next.

10. Enter the commencement date of the business. This is necessary to determine the basis
period rules. In cases where you do not know the date of commencement (it may have been
many years ago), we recommend that you select an agreed ‘practice date’ that staff working
on the case will recognise.

You can enter tax data for a year other than the current tax year. Change the tax year using
the up and down arrows next to the box. If you make no changes, the system will default to
the current tax year for entry of tax details. Click Next.

11. Optional: Assign staff members to the client by clicking on the magnifying glass button. This
page is only displayed if you chose to set the client up for a tax product at the beginning of
this wizard. Click Next.

12. Optional: Apply levels of security to your client.

If you apply a password to the client, you will need to enter the password in order to enter
any tax programs for this client, and in order to view the Main Details for the client.

You can also exclude clients from reports. This is especially useful when the business or
individual is part of your own practice.

Note: The administrator password can be used to override these security passwords.

Click Next.

13. The final page of the New PartnershipWizard shows a summary of the details you have
entered for this client. Click Back to change any of your previous choices or Next to continue.

14. Partnerships must have an accounting period set up in order to open the client in Business
Tax.

You can choose to create an accounting period now, by leaving the option Enter an
accounting period for this client now selected and clicking Continue.

Clicking Finish will create the client, and the client and any new linked individuals will appear
in the client list.

In Help, look for: Users and Clients > Creating a New Client then read the topics in the books
beginning with 'Add New'
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Chapter 5

Other Features
Control Centre has some very useful additional features.

Report Generator
A comprehensive report generator that supports a wide range of predefined reports and facilitates
the design of your own reports. This includes fully customisable report layouts, with many
predefined and unlimited user-definable data types.

In Help, look for: Reports > What are Reports?

Letter Generator
As well as supporting predefined letter types, the generator also provides the facility for the user to
design their own custom letters via integration with Microsoft® Office. Custom letters can be
created from scratch or be based on any existing letter template andmay include a wide range of
predefined Control Centre and Personal Tax data types, as well as unlimited user-definable data
types.

The letter and report generator can combine to provide a very powerful mail merge facility that
allows you to easily produce large numbers of letters based on the data in your reports.

In Help, look for: Letters > Letters in Control Centre

Tasks
It is possible to create a list of tasks to be carried out. Tasks created can be assigned to users and/or
clients. It is also possible to configure Control Centre to show your task list each time you enter the
software by ticking the ‘Show tasks at startup’ option on the main Tasks screen.

In Help, look for: Getting to know Control Centre > Tasks > General Information

Services
The Services tab allows you to identify which services are provided for each client, with the choice of
services available being relevant to the client type. You may also enter your own custom service
information. You can enter dates between which you provided each service.

In Help, look for: Client Information > Client Navigator > Services > What is a Service?

Acknowledgement
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The Letters of Engagement supplied with the Letter Generator are based on example letters
produced by, and reproducedwith the permission of, the Chartered Institute of Taxation (Registered
Charity number 1037771), the Association of Taxation Technicians (Registered Charity number
803480) and the Institute of Chartered Accountants in England andWales.
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